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Notes for Using FLR-1600A and FLV-4600A Water Flow Devices
►► USE ONLY PURE, CLEAN DI OR DISTILLED WATER IN THIS DEVICE. 
►► DO NOT use tap water or water with any biological components, minerals 

or oils. Any of these substances will affect the viscosity of the water 
(creating flow measurement inaccuracies). More importantly, these 
impurities will quickly build up in the laminar flow zone, cause corrosion, 
and render the measuring capabilities of the device useless. Pure DI 
water itself is corrosive to some extent, but it is the contaminants in 
your system that will be most detrimental to your FLR-1600A Series 
liquid water flow meter.  
If you cannot meet the requirement of pure water, then do not use this 
water flow device in your application. Damage caused by impurity build 
up is not covered by the warranty.

►► Please read the operating manual that accompanied your device. Keep 
the manual for future reference.

►► When first using the Omega water meter or controller for the day, please 
take the following precautions:
1.	 Apply your source pressure (approx. 20-30 psig for best results) to 

the device with the downstream flow blocked off. 
2.	 Then slightly open both bleed ports (DO NOT completely remove 

the screws) and allow any trapped air to escape. Allow some flow 
and let water pass through while bleeding (if the unit is a controller 
be sure to give it at least a 50% set-point). See page 10 of the 
manual for more information regarding bleed ports and bleeding.

3.	 Try not to get any water in-between the black electronics case and 
the stainless steel flow body. Wipe up any excess water around 
these seams. 

4.	 Tighten up both bleed screws, and then block the downstream 
water flow again. Visually verify zero flow through. 

5.	 Now you can safely tare (zero) a meter (page 18) using the tare 
button on the device, or in the case of a water flow controller, 
command the zero set‑point (page 27) which will auto-tare the unit.

►► Smooth and consistent source pressure is highly preferable, as any pulsing 
or fluctuation in water pressure will hydraulically couple to the differential 
pressure sensor, and the resultant flow reading will jump analogously.

►► Please note that, depending on model and flow range, water flow meters 
have an inherent internal pressure drop higher than that of standard gas 
flow meters of similar flow range. The minimum water device pressure 
drop is 2 psig, going all the way to 20 psig drop in certain models. Your 
source input pressure must meet or exceed this specification, in addition 
to any back pressure you may have on the downstream end of your 
process. Please see pages 47 and 49 of the manual.

Please contact Omega if you have any questions. We will be happy to help.
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Thank you for purchasing an FLR-1600A Series Water Flow Meter or 
FLV‑4600A Water Flow Controller. 

Please take the time to find and read the information contained in this 
manual. This will help to ensure that you get the best possible service 
from your instrument. This manual covers the following instruments:

	 FLR-1600A Series Water Flow Meters

	 FLV-4600A Series Water Flow Controllers

	 FLR-1600A-B Series Portable Water Meters
(Note: All FLR-1600A-B Portable Water Meters operate 
in accordance with the instructions found in this manual. 
Please see page 44 for information regarding portable meter 
operation.)

Please contact Omega if you have any questions regarding the use 
or operation of this device.

Many Omega  instruments are built for specific applications. Two 
instruments with the same flow range and part number may 
look and act quite differently depending upon the application the 
instrument was built for. Care should be taken when moving an 
instrument from one application to another.
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GETTING STARTED
8 Pin MiniDIN

Display Screen

Inlet Connection Port

Flow Direction Arrow

Outlet Connection Port

Power Jack

Bleed Screws

FLR-1600A Water Flow Meter shown with connection port fittings

Inlet Connection Port
Outlet Connection Port

Control Valve

FLV-4600A Small Valve Water Flow Controller shown with the standard downstream 
valve and connection port fittings

Inlet Connection Port

Outlet Connection Port

Control Valve

FLV-4600A Large Valve Water Flow Controller shown with the standard 
downstream valve and connection port fittings
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MOUNTING
All FLR-1600A Series Meters and FLV-4600A Series Controllers have mounting 
holes for convenient mounting to flat panels. The sizes and dimensions for the 
mounting holes are shown on pages 47-51.
Meters are position insensitive and can be mounted in any orientation. 
Small valve controllers can usually be mounted in any position. 
Large valve controllers should be mounted so that the valve cylinder is vertical. 
Mounting a large valve controller in another position increases the risk of 
leakage when the controller is being held closed by the spring force.
Note: For applications that may continuously introduce occasional air bubbles 
to the flow stream upstream of the device, the device may be mounted 
upside down to prevent the bubbles from becoming trapped in the differential 
pressure sensor ports. 

If the device has been installed upside down, avoid using the bleed 
screws as water may leak into the electronics housing causing 
permanent damage that is not covered under warranty!

PLUMBING
Your controller is shipped with plastic plugs fitted in the port openings. 
To lessen the chance of contaminating the flow stream do not remove 
these plugs until you are ready to install the device.

Make sure that the water will flow in the direction indicated by the flow arrow.
Standard FLR-1600A Series Meters and FLV-4600A Series Controllers have 
female inlet and outlet port connections. Welded VCR and other specialty 
fittings may have male ports.
The inlet and outlet port sizes (process connections) for different flow ranges 
are shown on pages 47-51.
Instruments with M5 (10-32) ports have O-ring face seals and require no 
sealant or tape. Do not use tape with welded or o-ring fittings.
For non-M5 (10-32) ports use thread sealing PTFE tape to prevent leakage 
around the port threads. 
Do not wrap the first two threads. This will minimize the possibility of getting 
tape into the flow stream and flow body. 

Do not use pipe dopes or sealants on the process connections as these 
compounds can cause permanent damage to the controller should they get 
into the flow stream.

When changing fittings, carefully clean any tape or debris from the port threads.
We recommend that a 20 micron filter be installed upstream of meter/
controllers with full scale ranges of 100 ccm or less and a 40 micron filter be 
installed upstream of meter/controllers with full scale ranges above 100 ccm.

Avoiding long runs of small diameter tubing upstream or downstream 
of the device will reduce water hammer.
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PRESSURE
Maximum operati ng line pressure is 100 psig (689 kPa). If the line pressure is 
higher than 100 psig (689 kPa), use a pressure regulator upstream from the 
fl ow controller to reduce the pressure to 100 psig (689 kPa)or less. 
Although the meter’s operati on is uni-directi onal, reversing the fl ow directi on 
will infl ict no damage as long as the maximum specifi ed limits are not 
exceeded. The diff erenti al pressure sensor uti lized in this fl ow meter/controller 
is a very sensiti ve device capable of detecti ng minute diff erences in pressure.
Smooth and consistent source pressure is highly preferable, as any pulsing 
or fl uctuati on in water pressure will hydraulically couple to the diff erenti al 
pressure sensor, and the resultant fl ow reading will jump analogously.
Please note that, depending on model and fl ow range, water fl ow meters have 
an inherent internal pressure drop higher than that of standard gas fl ow meters 
of similar fl ow range. The minimum water device pressure drop is 2 psig, going 
all the way to 20 psig drop in certain models. Your source input pressure must 
meet or exceed this specifi cati on, in additi on to any back pressure you may 
have on the downstream end of your process. 

CAUTION!  E�������� ��� ������� ��������� ���� �������� ��� 
����� ��������� ������ �� ��� �����-����� ������������ �������� 
����������.
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BLEED PORTS
FLR-1600A and FLV-4600A-Series flow meters and controllers are equipped 
with bleed ports on the front to aid in the removal of air bubbles from the 
differential pressure sensor ports. The bleed ports consist of a threaded hole 
with an 8-32 nylon tipped screw. After installation or anytime it is suspected 
that air may be trapped in the sensor ports, bleed the ports as follows:

A small amount of water will leak from the device during this 
procedure. Take necessary precautions to prevent the leaking water 
from damaging anything around the unit, taking special care to avoid 
any live electrical devices or lines.

1.	 With the meter/controller installed and line pressure applied, gently loosen 
the upstream bleed port screw 1-2 turns or until water begins to leak from 
the threads. DO NOT REMOVE THE SCREW as the port is subject to line 
pressures and injury, equipment damage or loss of required parts may result!

2.	 Gently tap the flow body (a wooden or plastic screwdriver handle works 
well for this) to encourage air bubbles to exit the port.

3.	 Any air in the port will generally be removed as the water leaks out even 
though you may not see or hear it.

4.	 Gently tighten the screw until the leakage stops, taking care not to crush 
the nylon tip.

Repeat steps 1-4 with the second bleed port.

If your device is mounted in an inverted position avoid using the 
bleed screws as water may leak into the electronics housing causing 
permanent damage that is not covered under warranty!

8-32 Nylon Tipped Bleed Screw
5/64 Hex  Loosen to Bleed
DO NOT REMOVE!



11

POWER AND SIGNAL CONNECTIONS
Power can be supplied to your meter/controller through either the power jack or 
the 8 pin Mini-DIN connector. 
An AC to DC adapter which converts line AC power to DC voltage and current as 
specifi ed below is required to use the power jack. 
A 2.1mm, positi ve center, 7-30 Vdc AC/DC adapter rated for at least 100 mA is 
required to use the adapter jack in a FLR-1600A meter.
A 2.1mm, positi ve center, 12-30 Vdc AC/DC adapter rated for at least 250 mA is 
required to use the adapter jack in a Small Valve controller. 
A 2.1mm, positi ve center, 24-30 Vdc AC/DC adapter rated for at least 500 mA is 
required to use the adapter jack in a Large Valve controller.

NOTE: 4-20mA analog output requires at least 15 Vdc.

It is common to mistake Pin 2 (labeled 5.12 Vdc Output) as the standard 0-5 Vdc 
analog output signal. In fact Pin 2 is normally a constant 5.12 Vdc that refl ects the 
system bus voltage and can be used as a source for the set-point signal.

For DB15 Pin-outs see pages 53 to 58.

Standard 8 Pin Mini-DIN Pin-Out



 







1 2

3 4 5

6 7 8

Pin Functi on Mini-DIN 
cable color

1 Not Connected (or opti onal 4-20mA Primary Output Signal) Black

2 Stati c 5.12 Vdc [or opti onal Secondary Analog Output (4-20mA, 
5Vdc, 10Vdc) or Basic Alarm] Brown

3 Serial RS232RX / RS485(–) Input Signal (receive) Red

4 Meters = Remote Tare (Ground to Tare)
Controllers = Analog Set-Point Input Orange

5 Serial RS232TX  / RS485(+) Output Signal (send) Yellow
6 0-5 Vdc (or opti onal 0-10 Vdc) Output Signal Green
7 Power In (as described above) Blue
8 Ground (common for power, communicati ons and analog signals) Purple

Note: The above pin-out is applicable to all the fl ow meters and controllers with the 
Mini-DIN connector. The availability of diff erent output signals depends on the opti ons 
ordered. Opti onal confi gurati ons are noted on the unit’s calibrati on sheet.

CAUTION! D� ��� ������� ����� �� ���� 1 ������� 6 �� ��������� 
������ ��� �����!
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INPUT SIGNALS
Analog Input Signal
Apply analog input to Pin 4 as shown on page 11.
For DB15 Pin-outs see pages 53 to 58.
Standard 0-5 Vdc is the standard analog input signal. Apply the 0-5 Vdc input 
signal to pin 4, with common ground on pin 8. 
Opti onal 0-10 Vdc: If specifi ed at ti me of order, a 0-10 Vdc input signal can be 
applied to pin 4, with common ground on pin 8.
Opti onal 4-20 mA: If specifi ed at ti me of order, a 4-20 mA input signal can be 
applied to pin 4, with common ground on pin 8. 
NOTE: This is a current sinking device. The receiving circuit is essenti ally a 250 
ohm resistor to ground.  
NOTE: 4-20mA output requires at least 15 Vdc power input.

CAUTION!  D� ��� ������� ���� ������ �� “���� �������’” 
�������, �� ���� ���� ������� �������� �� ��� ��������� ��� ���� 
��� ��������. I� ��� ���� ��������� ���� �������� ���� ������� 
�������, ������ ��� � ������ �������� ��� � �������� ����� ������.

Gauges: A remote tare can be achieved by momentarily grounding pin 4 to tare. 

 

7 6

5 4 3

2 1

8

5.12 Vdc

50 KOhm 
Potentiometer

0-5 Vdc

Controllers: A simple method for providing set-point to controllers

4

8
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RS232 / RS485 Digital Input Signal

To use the RS232 or RS485 input signal, connect the RS232 / RS485 Output 
Signal (Pin 5), the RS232 / RS485 Input Signal (Pin 3), and Ground (Pin 8) to your 
computer serial port as shown below. (See page 30 for details on accessing 
RS232 / RS485 input.)

DB9 to Mini-DIN Connection for RS232 / RS485 Signals













9 8 7 6



9876

15 3 24 1 532 4

Serial Cable End PC Serial Port


 









 











1

8 7 6

5

4

3

2

8 Pin MiniDIN Cable End 8 Pin MiniDIN Connector

9 Pin Serial Connection 8 Pin MiniDIN Connection
Pin Function Function Pin
5 Ground Ground 8
3 Transmit Receive 3
2 Receive Transmit 5
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OUTPUT SIGNALS

RS232 / RS485 Digital Output Signal

To use the RS232 or RS485 output signal, it is necessary to connect the RS232 / 
RS485 Output Signal (Pin 5), the RS232 / RS485 Input Signal (Pin 3), and Ground 
(Pin 8) to your computer serial port as shown on page 8. (See page 31 for 
details on accessing RS232 / RS485 output.)

Standard Voltage (0-5 Vdc) Output Signal

Meters/controllers equipped with a 0-5 Vdc (opti onal 0-10 Vdc) will have this 
output signal available on Pin 6. This output is generally available in additi on to 
other opti onally ordered outputs. This voltage is usually in the range of 0.010 
Vdc for zero fl ow and 5.0 Vdc for full-scale fl ow. The output voltage is linear 
over the enti re range. Ground for this signal is common on Pin 8.

Opti onal 0-10 Vdc Output Signal

If your meter/controller was ordered with a 0-10 Vdc output signal, it will be 
available on Pin 6. (See the Calibrati on Data Sheet that shipped with your meter 
to determine which output signals were ordered.) This voltage is usually in the 
range of 0.010 Vdc for zero fl ow and 10.0 Vdc for full-scale fl ow. The output 
voltage is linear over the enti re range. Ground for this signal is common on Pin 8.

Opti onal Current (4-20 mA) Output Signal

If your meter/controller was ordered with a 4-20 mA current output signal, it 
will be available on Pin 1. (See the Calibrati on Data Sheet that shipped with 
your meter to determine which output signals were ordered.) The current 
signal is 4 mA at 0 fl ow and 20 mA at the meter’s full scale fl ow. The output 
current is linear over the enti re range. Ground for this signal is common on Pin 
8. (Current output units require 15-30 Vdc power.)

Opti onal 2nd Analog Output Signal

You may specify an opti onal 2nd analog output on Pin 2 at ti me of order. (See 
the Calibrati on Data Sheet that shipped with your meter to determine which 
output signals were ordered.) This output may be a 0-5 Vdc, 0-10 Vdc, or 
4-20 mA analog signal that can represent any measured parameter. With this 
opti onal output, a meter could output the volume fl ow rate (0-5 Vdc on pin 6) 
and the line temperature (0-5 Vdc on pin 2). 

If your device is equipped with the opti onal six pin industrial connector, 
please contact Omega.

CAUTION!  D� ��� ������� ���� ������ �� “���� �������’” 
�������, �� ���� ���� ������� �������� �� ��� ��������� ��� ���� 
��� ��������. I� ��� ���� ��������� ���� �������� ���� ������� 
�������, ������ ��� � ������ �������� ��� � �������� ����� ������.
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Typical Multi ple Device (Addressable) Wiring Confi gurati on

The easiest way to connect multi ple devices is with a Multi -Drop Box 
(see page 45).

CAUTION!  D� ��� ������� ���� ������ �� “���� �������’” 
�������, �� ���� ���� ������� �������� �� ��� ��������� ��� ���� 
��� ��������. I� ��� ���� ��������� ���� �������� ���� ������� 
�������, ������ ��� � ������ �������� ��� � �������� ����� ������.

5
3

2

Purple

Red
Yellow

Purple

Red
Yellow

5 4 3 2 1

9
8 7

6

Unit C

Unit B

Unit A

Female Serial Cable Front

Purple (Ground)

Red
Yellow
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Information for Omega TFT (Color Display) Instruments
Omega TFT (color display) instruments have a high contrast back-lit LCD display. 
TFT instruments operate in accordance with Omega standard operating instructions 
for our monochrome menus and displays with the following differences.

Multi-Color Display Color Codes:

GREEN: Green labels identify the parameters and/or adjustments 
associated with the button directly above or below the label.

WHITE: The color of each parameter is displayed in white while operating 
under normal conditions.

RED: The color of a parameter is displayed in red when operating 
conditions for that parameter exceed 128% of the device’s specifications.

YELLOW: Yellow is the equivalent of the selection arrow on the 
monochrome display.

LCD Contrast: 
LCD contrast is ranged from 1 to 11 on color displays with 11 being the greatest 
contrast.

Display On/Off: 
Pushing the button under the Omega name will turn the device display on or 
off. This feature is not available on monochrome displays.

Technical Data for TFT (Color Display) Meters, Gauges and Controllers

The following specifications are applicable to Omega TFT (color display) meters, 
gauges and controllers only. All other operating specifications are shown in 
the Technical Data page for standard Omega instruments. All standard device 
features and functions are available and operate in accordance with the Omega 
operating manual provided with the device. 

Specification Meter  or 
Gauge

Small Valve 
Controller

Large Valve 
Controller

Supply Voltage 7 to 30 Vdc 12 to 30 Vdc 24 to 30 Vdc
Supply Current 80 mA @ 12Vdc

70 mA @ 24Vdc
290 mA @ 12Vdc
200 mA @ 24Vdc

780 mA @ 
24Vdc
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The Main display shows, temperature 
and volume flow. Line pressure will be 
also be displayed if the meter was order 
with this option.
Pressing the button adjacent to a 
parameter will make that parameter 
the primary display unit.
By hitting the MENU button at the 
bottom right of the screen you will 
enter the Select Menu display. 

If your meter was ordered with the 
Totalizer option (page 42), pushing the 
TOTAL button once will bring up the 
Totalizing Mode display. Pushing MENU 
will bring up the Select Menu display.

DISPLAYS AND MENUS FLR-1600A METERS
(Displays and Menus for FLV-4600A Controllers are shown beginning page 24.)

The device screen defaults to Main display as soon as power is applied to the meter.

Select Menu
From Select Menu you can interact 
with your RS232 / RS485 settings or 
read manufacturer’s data. 
Push MAIN to return to the Main display.

MENU

CCM
+0.0

CCM

TOTAL/ 
TIMER

Totalizer (option only)

RS232 
COMM

MFG
DATA

MAIN

MISC

Select Menu

#C
+21.50

+0.000
     CCM MENU

TARE V 

CCM

PSIG
+13.60

+   .

Main

BACK RESET

0000:00:00
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MAIN 
This mode defaults on power up, with flow 
as the primary displayed parameter. 
The following parameters are displayed in 
the Main mode.
Line Pressure: Only on units equipped with 
the optional pressure sensor, pressing 
the PSIG button will move the line gauge 
pressure to the primary display.

Line Temperature: Pressing the °C button 
will move the process temperature to the 
primary display.
Pushing the button again allows you 
to select 0C (Celsius), 0K (Kelvin), 0F 
(Fahrenheit) or 0R (Rankine) for the 
temperature scale. 
To select a temperature scale, use the LN‑UP 
and LN-DN buttons to position the arrow in 
front of the desired scale. 
Press SET to record your selection and 
return to the MAIN display. The selected 
temperature scale will be displayed on 
the screen.

Tare: Pushing the TARE V button tares the 
flow meter and provides it with a reference 
point for zero flow. This is an important 
step in obtaining accurate measurements. 

It is best to zero the flow meter each time it is powered up. If the flow reading 
varies significantly from zero after an initial tare, give the unit a minute or so to 
warm up and re-zero it.

If possible, zero the unit near the expected operating pressure by positively blocking 
the flow downstream of the flow meter prior to pushing the TARE button. 

Zeroing the unit while there is any flow will directly affect the accuracy 
by providing a false zero point. If in doubt about whether a zero flow 

condition exists, remove the unit from the line and positively block both ports 
before pressing the TARE button. If the unit reads a significant negative value 
when removed from the line and blocked, it was given a false zero. It is better 
to zero the unit at atmospheric pressure and a confirmed no flow condition 
than to give it a false zero under line pressure.

It is not uncommon for a meter to read a small value when it is removed from 
the process line as water can “hang” in one or both of the differential pressure 
sensor ports. If the unit reads a significant negative value when removed from 
the line and blocked, it is a good indication that it was given a false zero.

#C
+21.50

+0.000
CCM MENU

TARE V

CCM

PSIG
+13.60

+   .

LN-DN

CANCEL SET

MODE

  >#C
    #K
    #F
    #R
   

LN-UP
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SELECT MENU
From Select Menu you can interact with your RS232 / RS485 setti  ngs or read 
manufacturer’s data.
Press the butt on next to the desired operati on to bring that functi on to the screen.

An explanati on for each screen can be found on the following pages.

RS232 
COMM

MFG
DATA

MAIN

MISC

Miscellaneous
Communicati on Select

Main

Manufacturer Data

#C
+21.50

+0.000
CCM MAIN

TARE V

CCM

PSIA
+13.60

+   .

MODEL
INFO

BACK MAIN

MISC2

BACK MAIN

MISC1

BACK MAIN

UNIT ID
A

BAUD
19200

Select Menu

Volume: The volume fl ow rate is defaulted on the primary display. Press the 
unit of measure butt on (ccm in the example above) to return the volume fl ow 
rate to the primary display.
MENU: Pressing MENU switches the screen to the Select Menu display.

Flashing Error Message: An error message ( VOV = volumetric 
overrange, POV = pressure overrange, TOV = temperature overrange) 
fl ashes when a measured parameter exceeds the range of the sensor. 
When any item fl ashes, neither the fl ashing parameter nor the fl ow 

measurement is accurate. Reducing the value of the fl ashing parameter to within 
specifi ed limits will return the unit to normal operati on and accuracy. 

If the unit does not return to normal operati on contact Omega.
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COMMUNICATION SELECT
Access Communication Select by pressing 
the button above RS232 COMM or RS485 
COMM on the Select Menu display. 
Unit ID – Valid unit identifiers are the 
letters A-Z and @. The identifier allows 
you to assign a unique address to each 
device so that multiple units can be 
connected to a single RS232 or RS485 
computer port. 
Press UNIT ID. Use the UP and DOWN 
buttons to change the Unit ID. Press SET to 
record the ID. Press Reset to return to the 
previously recorded Unit ID.
Any Unit ID change will take effect when 
Communication Select is exited.
If the symbol @ is selected as the Unit 
ID, the device will enter streaming mode 
when Communication Select is exited. 
See RS232 Communications (page 31) for 
information about the streaming mode.
Baud – Both this instrument and your 
computer must send/receive data at the 
same baud rate. The default baud rate for 
this device is 19200 baud. 
Press the Select button until the arrow is 
in front of Baud. Use the UP and DOWN 
buttons  to select the baud rate that 
matches your computer. The choices are 
38400, 19200, 9600, or 2400 baud. 
Any baud rate change will not take effect 
until power to the unit is cycled.

UP

BACK RESET A SET

UNIT ID
C

DN

DN

BACK SET

BAUD UP

19200

BACK MAIN

UNIT ID
A

BAUD
19200

C
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MISCELLANEOUS 
Miscellaneous is accessed by pressing the MISC button on the Select Menu display. 
Next select either MISC1 or MISC2. 

MISC1 will display as shown at left.
ZERO BAND refers to Display Zero Deadband. 
Zero deadband is a value below which the display 
jumps to zero. This deadband is often desired to 
prevent electrical noise from showing up on the 
display as minor flows or pressures that do not 
exist. Display Zero Deadband does not affect the 
analog or digital signal outputs.
ZERO BAND can be adjusted between 0 and 
3.2% of the sensor’s Full Scale (FS). 
Press ZERO BAND. Then use SELECT to choose 
the digit with the arrow and the UP and DOWN 
buttons to change the value. Press SET to record 
your value. Press CLEAR to return to zero.
Pressure Averaging and Flow Averaging may 
be useful to make it easier to read and interpret 
rapidly fluctuating pressures and flows. Pressure 
and flow averaging can be adjusted between 1 
(no averaging) and 256 (maximum averaging). 
These are geometric running averages where 
the number between 1 and 256 can be 
considered roughly equivalent to the response 
time constant in milliseconds. 

This can be effective at “smoothing” high frequency process oscillations such as 
those caused by diaphragm pumps. 
Press PRESS AVG. Then use SELECT to choose the digit with the arrow and the UP and 
DOWN buttons to change the value. Press SET to record your value. Press CLEAR to 
return to zero.

Press FLOW AVG. Then use SELECT to choose the 
digit with the arrow and the UP and DOWN buttons 
to change the value. Press SET to record your value. 
Press CLEAR to return to zero.
Setting a higher number will equal a smoother 
display. 
LCD CONTRAST: The display contrast can be 
adjusted between 0 and 30, with zero being the 
lightest and 30 being the darkest. Use the UP 
and DOWN buttons to adjust the contrast. Press 
SET when you are satisfied. Press CANCEL to 
return to the MISC display.

PRESS
AVG

BACK

LCD

CONTRAST MAIN

ZERO
BAND

FLOW
AVG

DOWN

CANCEL CLEAR SET

UP SELECT

0.0

>

DOWN

CANCEL RESET SET

UP

11
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MISC2 will display as shown at left. 
Press ROTATE DISP and SET to Inverted 180° 
if your device is inverted. The display and 
buttons will rotate together.
If the device has been installed upside 
down, avoid using the bleed screws as 
water may leak into the electronics housing 
causing permanent damage that is not 
covered under warranty!

DIAG
TEST

BACK MAIN

ROTATE 
DISP

BACK MAIN

SCROLL
R8:     AP Sig	 7871
R9:     Temp Sig	 39071
R10:    DP Side	 9986
R11:     DP Brdg	 36673
R13:    AP Brdg	 36673
R16:    Meter Fun	 199
R18:    Power Up	 32768

DIAG TEST: This diagnostic screen displays 
the initial register values configured by the 
factory, which is useful for noting factory 
settings prior to making any changes. It is 
also helpful for troubleshooting with Alicat 
customer service personnel.
Select the DIAG TEST button from the MISC2 
screen to view a list of select register values. 
Pressing the SCROLL button will cycle the 
display through the register screens. An 
example screen is shown at left.
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MANUFACTURER DATA
Manufacturer Data is accessed by pressing 
the MFG DATA button on the Select Menu 
display. 

The initial display shows the name and 
telephone number of the manufacturer.

Press MODEL INFO to show important 
information about your flow meter 
including the model number, serial 
number, and date of manufacture. 

Press BACK to return to the MFG DATA 
display.

Push MAIN to return to the Main display.

MODEL
INFO

BACK MAIN1

BACK MAIN

O M E G A

Ph    800-826-6342

Fax  203-359-7700

MODEL:  FLR-1600A-10SLPM-D
SERIAL  � NO:  80003
DATE  MFG:    � 10/7/2014
DATE  CAL:  �   10/9/2014
CAL  BY: �  DL
SW REV:  � 2V62
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The Main display shows, temperature 
and volume flow. Line pressure will be 
also be displayed if the meter was order 
with this option.
Pressing the button adjacent to a 
parameter will make that parameter 
the primary display unit.
By hitting the MENU button at the 
bottom right of the screen you will 
enter the Select Menu display. 

If your controller was ordered with the 
Totalizer option (page 42), pushing the 
TOTAL button once will bring up the 
Totalizing Mode display. Pushing MENU 
will bring up the Select Menu display.

DISPLAYS AND MENUS FLV-4600A CONTROLLERS
(Displays and Menus for FLR-1600A Meters are shown beginning page 17.)

The device screen defaults to Main display as soon as power is applied to the controller.

Select Menu
From Select Menu you can interact 
with your RS232 / RS485 settings, 
read manufacturer’s data or access 
the control set-up display. 
Push MAIN to return to the Main display.

SETPT

MENU

CCM
+0.0

CCM

TOTAL/ 
TIMER

Totalizer (option only)

CONTROL
SETUP

RS232 
COMM

MFG
DATA

MAIN

MISC

Select Menu

#C
+21.50

+0.000
     CCM MENU

SETPT
0.000  

CCM

PSIA
+13.60

+   .

Main

BACK RESET

0000:00:00
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MAIN 
This mode defaults on power up, with fl ow 
as the primary displayed parameter. 
The following parameters are displayed in 
the Main mode.
Line Pressure: Only on units equipped with 
the opti onal pressure sensor, pressing 
the PSIG butt on will move the line gauge 
pressure to the primary display.

Line Temperature: Pressing the °C butt on 
will move the process temperature to the 
primary display.
Set Point: The set-point (SETPT)is shown 
in the upper right of the display. 

For informati on on changing the set-point see SETPT SOURCE, page 27.

Volume: The volume fl ow rate is defaulted on the primary display. Press the 
unit of measure butt on (ccm in the example above) to return the volume fl ow 
rate to the primary display.
MENU: Pressing MENU switches the screen to the Select Menu display.

#C
+21.50

+0.000
CCM MENU

SETPT
0.000  

CCM

PSIG
+13.60

+   .

Flashing Error Message: An error message ( VOV = volumetric 
overrange, POV = pressure overrange, TOV = temperature overrange) 
fl ashes when a measured parameter exceeds the range of the sensor. 
When any item fl ashes, neither the fl ashing parameter nor the fl ow 

measurement is accurate. Reducing the value of the fl ashing parameter to within 
specifi ed limits will return the unit to normal operati on and accuracy. 

If the unit does return to normal operati on contact Omega.
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CONTROL
SETUP

RS232 
COMM

MFG
DATA

MAIN

MISC

SELECT MENU
From Select Menu you can interact with your RS232 / RS485 settings, read 
manufacturer’s data and access the control setup screen.
Press the button next to the desired operation to bring that function to the screen.

Miscellaneous
Communication Select

Control Setup

Main

Manufacturer Data

An explanation for each screen can be found on the following pages:
Control Setup: Please see page 27.

Communication Select: Please see page 20.

Miscellaneous: Please see page 21.

Manufacturer Data: Please see page 22.

#C
+21.50

+0.000
CCM MAIN

SETPT
0.000  

CCM

PSIG
+13.60

+   .

MODEL
INFO

BACK MAIN

LOOP
VAR

ON
AUTO PID MAIN

SETPT
SOURCE

MISC2

BACK MAIN

MISC1

BACK MAIN

UNIT ID
A

BAUD
19200

SETPT
+0.00  

Select Menu

O m e g a 

P h    8 0 0 - 8 2 6 - 6 3 4 2

F a x   2 0 3 - 3 5 9 - 7 7 0 0
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CONTROL SETUP 
Control Setup is accessed by pressing the button below Control Setup on the 
Select Menu display. From this screen you can select your set-point source, 
choose a loop variable and adjust the PID terms.

Press BACK to return to the Select Menu 
display. 
Press MAIN to return to the MAIN display
SETPT SOURCE – Pressing the button 
above SETPT SOURCE will allow you to 
select how the set point will be conveyed 
to your controller. 
Use the line-up and line-down buttons 
to move the arrow in front of the desired 
option. Then press SET.
Press CANCEL to return to the previous 
display. 
The controller will ignore any set-point 

except that of the selected set-point source and it will remember which input is 
selected even if the power is disconnected.

RS232 (or RS485) refers to a remote 
digital RS232 / RS485 set-point applied 
via a serial connection to a computer or 
PLC as described in the installation and 
RS232 / RS485 sections of this manual. 

Front Panel refers to a set-point applied 
directly at the controller. 

Front Panel input must be selected 
prior to changing the set-point at 
the device. 

Analog refers to a remote analog set-
point applied to Pin 4 of the Mini-DIN 
connector as described in the installation 

section of this manual. The standard analog input is 0-5 Vdc. 
To determine what type of analog set-point your controller has, refer to 
the Calibration Data Sheet that was included with your controller. 

If nothing is connected to Pin 4, and the controller is set for analog control, the 
device will generate random set-point values. 
NOTE: If your controller has the IPC (Integrated Potentiometer Control) option, 
the IPC dial will operate with the ANALOG set-point source selected.

SETPT refers to the set-point. This parameter may be changed using the display 
only if FRONT PANEL is selected as the Input. Press SETPT. Then use SELECT to 
choose the decimal with the arrow and the UP and DOWN buttons to change 
the value. Press SET to record your value. Press CLEAR to return to zero.

LN-DN

CANCEL SET

LN-UP MODE

 >RS232
   FRONT PANEL
   ANALOG

LOOP
VAR

ON
AUTO PID MAIN

SETPT
SOURCE

SETPT
+0.0
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CAUTION!  N���� ����� � C��������� ���� � ���-���� ���-����� �� 
�� �������� �� ��������� �� ���� ����. T�� ���������� ���� ����� 
���� ����� �� ��� ����� �� �� ������� �� ����� ��� ���-�����. 
W��� ����� �� �� ����, ���� ��� ���� ��� ����� ���� HOT!

CONTROL SETUP (conti nued)
LOOP VAR—Water fl ow controllers are 
defaulted to volume fl ow. 
Volume means that the controller is 
“closing the loop” on the volume fl ow 
rate. This means that when you give 
the controller a set-point, the controller 
compares that set-point to the measured 
volume fl ow rate and adjusts the valve 
to try to make the fl ow and the set-point 
match. For the volume fl ow rate, the input 
signal (e.g. 0-5 Vdc) corresponds to the 
full-scale fl ow rate for the device.

ON AUTO / OFF AUTO—refers to the 
standard auto-tare or “auto-zero” feature.

The auto-tare feature automati cally tares 
(takes the detected signal as zero) the unit 
when it receives a zero set-point for more 
than two seconds. 
A zero set-point results in the closing 
of the valve and a known “no fl ow” 
conditi on. This feature makes the device 
more accurate by periodically removing any 
cumulati ve errors associated with drift . 

It is recommended that the controller be left  in the default auto-tare 
ON mode unless your specifi c applicati on requires that it be turned off . 

LOOP
VAR

ON
AUTO PID MAIN

SETPT
SOURCE

LN-DN

CANCEL SET

LN-UP MODE

 >   Volumetric Flow
   

SETPT
+0.0
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PID TUNING

PID Values determine the performance 
and operation of your proportional 
control valve. These terms dictate control 
speed, control stability, overshoot and 
oscillation. All units leave the factory with 
a generic tuning designed to handle most 
applications. If you encounter issues with 
valve stability, oscillation or speed, fine 
tuning these parameters may resolve the 
problem.
FLR-1600A-Series controllers allow you 
to adjust the Proportional, Integral and 
Differential terms of the PID control loop. 
To change the PID loop parameters, push 
the button below PID.
Press LOOP TYPE. Then use the LN-UP and 
LN-DN buttons to select the appropriate 
PID control algorithm. Press SET.
See the following page for descriptions 
of the PID Loop Types (PID Control 
Algorithms).

P refers to the Proportional term of the 
PID loop. 
I refers to the Integral term of the PID loop. 
D refers to the Differential term of the PID 
loop. 
Press P, I or D. Then use SELECT to choose 
the decimal with the arrow and the UP 
and DOWN buttons to change the value. 
Press SET to record your value. Press 
CLEAR to return to zero.

Before changing the P, I or D 
parameter, please record the initial 
value so that it can be returned to 

the factory setting if necessary.
Valve tuning can be complex. If you 
would like assistance, please contact 
Omega for technical support.

I
00000

BACK
LOOP
TYPE MAIN

P
00100

D
02501

LN-DN

CANCEL SET

LN-UP MODE

 >PD PID
   PD2I PID

LOOP
VAR

ON
AUTO PID MAIN

SETPT
SOURCE

SETPT
+0.0
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The PD algorithm is the PID algorithm used on most FLV-4600A controllers.
It is divided into two segments:
The first compares the process value to the set-point to generate a proportional 
error. The proportional error is multiplied by the ‘P’ gain, with the result added 
to the output drive register. 
The second operates on the present process value minus the process value during 
the immediately previous evaluation cycle. This ‘velocity’ term in multiplied by 
the ‘D’ gain, with the result subtracted from the output drive register. 
The above additions to and subtractions from the output drive register 
are carried over from process cycle to process cycle, thus performing the 
integration function automatically. 
Increasing the ‘P’ gain will promote the tendency of the system to overshoot, 
ring, or oscillate. 
Increasing the ‘D’ gain will reduce the tendency of the system to overshoot. 
The PD2I algorithm is a PID algorithm used primarily for high performance 
pressure and flow control applications. 
It exhibits two basic differences from the PD algorithm that most controllers utilize.

1. Instead of applying a damping function based upon the rate of change of the 
process value, it applies a damping function based upon the square of the rate of 
change of the process value.
2. The damping function is applied directly to the proportional error term 
before that term is used in the proportional and integral functions of the 
algorithm. This provides a certain amount of ‘look ahead’ capability in the 
control loop.

Because of these differences, you will note the following:
1. Increasing ‘P’ gain can be used to damp out overshoot and slow oscillations 
in pressure controllers. You will know that ‘P’ gain is too high, when the 
controller breaks into fast oscillations on step changes in set-point. On flow 
controllers, too high a ‘P’ gain results in slower response times. Too low a ‘P’ 
gain results in overshoot and/or slow oscillation. A good starting value for ‘P’ 
gain is 200.
2. If the unit was originally shipped with the PD2I algorithm selected, the 
‘D’ gain value should be left at or near the factory setting because it relates 
primarily to the system phase lags. If you are changing from the default 
algorithm to the PD2I algorithm, you should start with a ‘D’ gain value of 20.
3. The ‘I’ gain is used to control the rate at which the process converges 
to the set-point, after the initial step change. Too low a value for ‘I’ gain 
shows up as a process value that jumps to near the set-point and then takes 
awhile to converge the rest of the way. Too high a value for ‘I’ gain results in 
oscillation. A good starting value for the ‘I’ gain is 200.
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RS232 / RS485 Output and Input
Configuring HyperTerminal®:

1.	 Open your HyperTerminal® RS232 / RS485 terminal program (installed under 
the “Accessories” menu on all Microsoft Windows® operating systems).

2.	 Select “Properties” from the file menu.
3.	 Click on the “Configure” button under the “Connect To” tab. Be sure the 

program is set for: 19,200 baud (or matches the baud rate selected in the 
RS232 / RS485 communications menu on the meter) and an 8-N-1-None (8 
Data Bits, No Parity, 1 Stop Bit, and no Flow Control) protocol.

4.	 Under the “Settings” tab, make sure the Terminal Emulation is set to ANSI 
or Auto Detect.

5.	 Click on the “ASCII Setup” button and be sure the “Send Line Ends with Line 
Feeds” box is not checked and the “Echo Typed Characters Locally” box 
and the “Append Line Feeds to Incoming Lines” boxes are checked. Those 
settings not mentioned here are normally okay in the default position.

6.	 Save the settings, close HyperTerminal® and reopen it.

Streaming Mode (RS485 units do not have a streaming mode)
In the default Polling Mode, the screen should be blank except the blinking cursor. 
In order to get the data streaming to the screen, hit the “Enter” key several times 
to clear any extraneous information. Type “*@=@” followed by “Enter” (or using 
the RS232 / RS485 communication select menu, select @ as identifier and exit 
the screen). If data still does not appear, check all the connections and COM port 
assignments.

Streaming Mode – Advanced 
The streaming data rate is controlled by register 91. The recommended default rate 
of data provision is once every 50 milliseconds and this is suitable for most purposes. 
If a slower or faster streaming data rate is desired, register 91 can be changed to a 
value from 1 millisecond to 65535 milliseconds, or slightly over once every minute. 
Below approximately 40 milliseconds, data provision will be dependent upon 
how many parameters are selected. Fewer data parameters can be streamed 
more quickly than more. It is left to the user to balance streaming speed with 
number of parameters streamed. 
To read register 91, type “*r91” followed by “Enter”. 
To modify register 91, type “*w91=X”, where X is a positive integer from 1 to 
65535, followed by “Enter”. 
To return to the recommended factory default streaming speed, type “*w91= 50”.
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Tareing via RS232 / RS485 (FLR-1600A Series only): 
Tareing (or zeroing) the flow meter provides it with a reference point for 
zero flow. This is a very simple but important step in obtaining accurate 
measurements. It is good practice to “zero” the flow meter each time it is 
powered up. 

If the flow reading varies significantly from zero after an initial tare, give the 
unit a minute or so to warm up and re-zero it. If possible, it is helpful to zero 
the unit near the expected operating pressure by positively blocking the flow 
downstream of the flow meter prior to entering the Tare command. Zeroing the 
unit while there is any flow will directly affect the accuracy by providing a false 
zero point. 

If in doubt about whether the flow is positively blocked, remove it from the line 
and positively block both ports before entering the Tare command. If the unit 
reads a significant negative value when removed from the line and blocked, it 
is a good indication that it was given a false zero. It is better to zero the unit at 
atmospheric pressure and a confirmed no flow conditions than to give it a false 
zero under line pressure. To send a Tare command via RS232 / RS485, enter the 
following strings:

In Polling Mode:		  Address$$V<Enter>        (e.g. B$$V<Enter>)
Sending a Set-point via RS232 / RS485: To send a set-point via RS232 / RS485, 
“Serial” must be selected under the “Input” list in the control set up mode. 
Method 1:  Set-point may be set in floating point in serial communication using 
serial command (UnitID)SX.YZ 

Example:  AS4.54 results in Unit ID A changing set-point to 4.54.  
Method 2: Type in a number between 0 and 65535 (2% over range), where 64000 
denotes full-scale flow rate, and hit “Enter”. 

The set-point column and pressure rates should change accordingly. If they do 
not, try hitting “Enter” a couple of times and repeating your command. The 
formula for performing a linear interpolation is as follows:

	 Value = (Desired Set-point X 64000) / Full Scale Flow Range

For example, if your device is a 500 ccm full-scale unit and you wish to apply a 
set-point of 125 ccm you would enter the following value:

 	 16000 = (125 ccm X 64000) / Full Scale Flow Range

If the controller is in polling mode as described in Changing from Streaming 
Mode to Polling Mode, the set-point must be preceded by the address of the 
controller. For example, if your controller has been given an address of D, the 
set-point above would be sent by typing:

 	 D16000 followed by “Enter”
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To adjust the Proportional and Differential (P&D) terms via RS232 / RS485 
(FLV-4600A Series only):

Type *@=A followed by “Enter” to stop the streaming mode of information.

To adjust the “P” or proportional term of the PID controller, type *R21   
followed by “Enter”.

The computer will respond by reading the current value for register 21 between 
0-65535. It is good practice to write this value down so you can return to the 
factory settings if necessary. Enter the value you wish to try by writing the new 
value to register 21. For example, if you wished to try a “P” term of 220, you 
would type *W21=220 followed by “Enter” where the bold number denotes the 
new value.

The computer will respond to the new value by confirming that 21=220. To 
see the effect of the change you may now poll the unit by typing A followed 
by “Enter”. This does an instantaneous poll and returns the values once. You 
may type A “Enter” as many times as you like. Alternately, you could resume 
streaming mode by typing *@=@ followed by “Enter”. Repeat step 3 to remove 
the unit from the streaming mode.

To adjust the “D” or proportional term of the PID controller, type *R22 followed 
by “Enter”.

The computer will respond by reading the current value for register 22 between 
0-65535. It is good practice to write this value down so you can return to the 
factory settings if necessary. Enter the value you wish to try by writing the new 
value to register 22. For example, if you wished to try a “D” term of 25, you 
would type *W22=25 followed by “Enter” where the bold number denotes the 
new value. 

The computer will respond to the new value by confirming that 22=25. To 
see the effect of the change you may now poll the unit by typing A followed 
by “Enter”. This does an instantaneous poll and returns the values once. You 
may type A “Enter” as many times as you like. Alternately you could resume 
streaming mode by typing *@=@ followed by “Enter”. Repeat. 

You may test your settings for a step change by changing the set-point. To do 
this type A32000 (A is the default single unit address, if you have multiple 
addressed units on your RS232 / RS485 line the letter preceding the value 
would change accordingly.) followed by “Enter” to give the unit a ½ full scale 
set-point. Monitor the unit’s response to the step change to ensure it is 
satisfactory for your needs. Recall that the “P” term controls how quickly the 
unit goes from one set-point to the next, and the “D” term controls how quickly 
the signal begins to “decelerate” as it approaches the new set-point (controls 
the overshoot).
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Changing From Streaming to Polling Mode: 

When the meter is in the Streaming Mode (RS485 units do not have a streaming 
mode), the screen is updated approximately 10-60 times per second (depending 
on the amount of data on each line) so that the user sees the data essentially in 
real time. It is sometimes desirable, and necessary when using more than one 
unit on a single RS232 line, to be able to poll the unit.

In Polling Mode the unit measures the flow normally, but only sends a line of 
data when it is “polled”. Each unit can be given its own unique identifier or 
address. Unless otherwise specified each unit is shipped with a default address 
of capital A. Other valid addresses are B thru Z.

Once you have established communication with the unit and have a stream of 
information filling your screen:

1.	 Type *@=A followed by “Enter” (or using the RS232 / RS485 
communication select menu, select A as identifier and exit the screen) to 
stop the streaming mode of information. Note that the flow of information 
will not stop while you are typing and you will not be able to read what you 
have typed. Also, the unit does not accept a backspace or delete in the line 
so it must be typed correctly. If in doubt, simply hit enter and start again. If 
the unit does not get exactly what it is expecting, it will ignore it. If the line 
has been typed correctly, the data will stop.

2.	 You may now poll the unit by typing A followed by “Enter”. This does an 
instantaneous poll of unit A and returns the values once. You may type A 
“Enter” as many times as you like. Alternately you could resume streaming 
mode by typing *@=@ followed by “Enter”. Repeat step 1 to remove the 
unit from the streaming mode.

3.	 To assign the unit a new address, type *@=New Address, e.g. *@=B. Care 
should be taken not to assign an address to a unit if more than one unit 
is on the RS232 / RS485 line as all of the addresses will be reassigned. 
Instead, each should be individually attached to the RS232 / RS485 line, 
given an address, and taken off. After each unit has been given a unique 
address, they can all be put back on the same line and polled individually.
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Collecting Data:

The RS232 / RS485 output updates to the screen many times per second. 
Very short-term events can be captured simply by disconnecting (there are 
two telephone symbol icons at the top of the HyperTerminal® screen for 
disconnecting and connecting) immediately after the event in question. The 
scroll bar can be driven up to the event and all of the data associated with 
the event can be selected, copied, and pasted into Microsoft® Excel® or other 
spreadsheet program as described below.

For longer term data, it is useful to capture the data in a text file. With the 
desired data streaming to the screen, select “Capture Text” from the Transfer 
Menu. Type in the path and file name you wish to use. Push the start button. 
When the data collection period is complete, simply select “Capture Text” from 
the Transfer Menu and select “Stop” from the sub-menu that appears.

Data that is selected and copied, either directly from HyperTerminal® or from 
a text file can be pasted directly into Excel®. When the data is pasted it will all 
be in the selected column. Select “Text to Columns...” under the Data menu in 
Excel® and a Text to Columns Wizard (dialog box) will appear. Make sure that 
“Fixed Width” is selected under Original Data Type in the first dialog box and 
click “Next”. In the second dialog box, set the column widths as desired, but 
the default is usually acceptable. Click on “Next” again.  In the third dialog box, 
make sure the column data format is set to “General”, and click “Finish”. This 
separates the data into columns for manipulation and removes symbols such 
as the plus signs from the numbers. Once the data is in this format, it can be 
graphed or manipulated as desired.

For extended term data capture see: “Sending a Simple Script to 
HyperTerminal®” on page 37.
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Data Format:

The data stream on the screen represents the flow parameters of the main 
mode in the units shown on the display. For FLR-1600A Series Flow Meters, 
there are three columns of data. The first column is line pressure (normally in 
psig and only in units equipped with the optional pressure sensor), the second 
column line temperature (normally in °C), and the third column is the volume 
flow rate in the units specified at time of order and shown on the display.

 +014.70  +025.00  +4.123
+014.70  +025.00  +4.123
+014.70  +025.00  +4.123
+014.70  +025.00  +4.123
+014.70  +025.00  +4.124
+014.70  +025.00  +4.125

FLR-1600A Series Water Flow Meter Data Format

For FLV-4600A Series Flow Controllers, there are four columns of data 
representing pressure, temperature, volume flow and set-point. The first 
column is line pressure (normally in psig and only in units equipped with the 
optional pressure sensor), the second column is temperature (normally in °C), 
the third column is volume flow rate (in the units specified at time of order and 
shown on the display), and the fourth column is the set-point (also in the units 
specified at time of order and shown on the display). For instance, if the meter 
was ordered in units of ccm, the display on the meter would read 2.004 ccm 
and the last two columns of the output below would represent volume flow 
and set-point in ccm respectively.

 +014.70  +025.00  +02.004  02.004
+014.70  +025.00  +02.005  02.004
+014.70  +025.00  +02.006  02.004
+014.70  +025.00  +02.005  02.004
+014.70  +025.00  +02.004  02.004
+014.70  +025.00  +02.004  02.004

FLV-4600A Series Water Flow Controller Data Format

Note: On units with the totalizer function a fourth column (meters) or fifth 
column (controllers) will show the totalizer value
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Sending a Simple Script File to HyperTerminal®

It is sometimes desirable to capture data for an extended period of time. 
Standard streaming mode information is useful for short term events, however, 
when capturing data for an extended period of time, the amount of data 
and thus the file size can become too large very quickly. Without any special 
programming skills, you can use HyperTerminal® and a text editing program 
such as Microsoft® Word® to capture text at defined intervals.

1. Open your text editing program, MS Word for example.

2. Set the cap lock on so that you are typing in capital letters.

3. Beginning at the top of the page, type A<Enter> repeatedly. If you’re using 
MS Word, you can tell how many lines you have by the line count at the bottom 
of the screen. The number of lines will correspond to the total number of times 
the flow device will be polled, and thus the total number of lines of data it will 
produce.
For example:	 A

	 A
	 A
	 A
	 A
	 A
will get a total of six lines of data from the flow meter, but you can 
enter as many as you like.

The time between each line will be set in HyperTerminal.
4. When you have as many lines as you wish, go to the File menu and select 
save. In the save dialog box, enter a path and file name as desired and in the 
“Save as Type” box, select the plain text (.txt) option. It is important that it be 
saved as a generic text file for HyperTerminal to work with it.

5. Click Save.

6. A file conversion box will appear. In the “End Lines With” drop down box, 
select CR Only. Everything else can be left as default.

7. Click O.K.

8. You have now created a “script” file to send to HyperTerminal. Close the file 
and exit the text editing program.

9. Open HyperTerminal and establish communication with your flow device as 
outlined in the manual.

10. Set the flow device to Polling Mode as described in the manual. Each time 
you type A<Enter>, the meter should return one line of data to the screen.

11. Go to the File menu in HyperTerminal and select “Properties”.

12. Select the “Settings” tab.
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13. Click on the “ASCII Setup” button.

14. The “Line Delay” box is defaulted to 0 milliseconds. This is where you will 
tell the program how often to read a line from the script file you’ve created. 
1000 milliseconds is one second, so if you want a line of data every 30 seconds, 
you would enter 30000 into the box. If you want a line every 5 minutes, you 
would enter 300000 into the box.

15. When you have entered the value you want, click on OK and OK in the 
Properties dialog box.

16. Go the Transfer menu and select “Send Text File…” (NOT Send File…).

17. Browse and select the text “script” file you created.

18. Click Open.

19. The program will begin “executing” your script file, reading one line at 
a time with the line delay you specified and the flow device will respond by 
sending one line of data for each poll it receives, when it receives it.
You can also capture the data to another file as described in the manual 
under “Collecting Data”. You will be simultaneously sending it a script file and 
capturing the output to a separate file for analysis.

FLOW MEASUREMENT OPERATING PRINCIPLE

All FLR-1600A or FLV-4600A Series Water Flow Meters/Controllers accurately 
determine the flow rate by creating a pressure drop across a unique internal 
restriction, known as a Laminar Flow Element (LFE), and measuring differential 
pressure across it. The restriction is designed so that the water molecules are 
forced to move in parallel paths along the entire length of the passage; hence 
laminar (streamline) flow is established for the entire range of operation of 
the device. Unlike other flow measuring devices, in laminar flow meters the 
relationship between pressure drop and flow is linear. 

In order to have an accurate reading of the flow rate, the absolute viscosity of 
the fluid must be established. The rate at which liquids change viscosity with 
changes in temperature is not linear. The relationship between temperature 
and viscosity for water is well established and FLR-1600A and FLV-4600A Series 
units utilize a high accuracy temperature sensor and this relationship to provide 
an accurate viscosity reference. For this reason, these meters and controllers 
are generally recommended only for use with pure water. Any additives to 
water (such as antifreeze or disinfectants) that might affect the viscosity should 
be avoided. 
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TROUBLESHOOTING
Display does not come on or is weak.
Check power and ground connections and supply voltage. Please reference 
the technical specifications (page 47-51) to assure you have the proper power 
for your model.
Flow reading is approximately fixed either near zero or near full scale regardless of 
actual line flow.
Differential pressure sensor may be damaged. A common cause of this problem 
is instantaneous application of high pressure as from a snap acting solenoid 
valve upstream of the meter. If you suspect that your pressure sensor is 
damaged please discontinue use of the device and contact Omega.
Displayed volumetric flow, pressure or temperature is flashing and message 
VOV, POV or TOV is displayed:
Our flow meters and controllers display an error message (VOV = volumetric 
overrange, POV = pressure overrange, TOV = temperature overrange) when 
a measured parameter exceeds the range of the sensors in the device. When 
any item flashes on the display, neither the flashing parameter nor the flow 
measurement is accurate. Reducing the value of the flashing parameter to 
within specified limits will return the unit to normal operation and accuracy. If 
the unit does not return to normal contact Omega.
Meter reads negative flow when there is a confirmed no flow condition.
This is an indication of an improper tare. If the meter is tared while there is 
flow, that flow is accepted as zero flow. When an actual zero flow condition 
exists, the meter will read a negative flow. Simply re-tare at the confirmed 
zero flow condition. Also note that while the meter is intended for positive 
flow, it will read negative flow with reasonable accuracy (it is not calibrated for 
bi‑directional flow) and no damage will result. See TARE page 18.
After installation, there is no flow.
FLV-4600A Series controllers incorporate normally closed valves and require a 
set-point to operate. Check that your set-point signal is present and supplied to 
the correct pin and that the correct set-point source is selected under the SETPT 
SOURCE list in the control set up display (page 26). Also check that the unit is 
properly grounded.
My controller does not respond to the set-point.
Check that your set-point signal is present and supplied to the correct pin and 
that the correct set-point source is selected under the SETPT SOURCE list in the 
control set up display (page 27). Also check that the unit is properly grounded.
The flow lags below the set-point.
Be sure there is enough pressure available to make the desired flow rate. If 
either the set-point signal line and/or the output signal line is relatively long, it 
may be necessary to provide heavier wires (especially ground wiring) to negate 
voltage drops due to line wire length. An inappropriate PID tuning can also 
cause this symptom if the D term is too large relative to the P term (page 28). 
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Meter does not appear to be accurate when compared against another valid 
measurement of the physical flow (such as weight over time).
Water flow meters can normally be compared against one another provided 
there are no leaks between the two meters. One common cause of inaccuracy, 
inconsistency, or unusual readings is air bubbles trapped in one or both of the 
legs of the differential pressure sensor. Bleed the ports as described in this 
manual to remove this possibility (See page 10). Another possibility is that the 
water has some contaminant or additive, such as antifreeze, that affects the 
viscosity of the water. A third possibility is an improper tare error (see page 18).
Controller is slow to react to a set-point change or imparts an oscillation to the flow.
An inappropriate PID tuning can cause these symptoms. Use at conditions 
considerably different than those at which the device was originally set up can 
necessitate a re-tuning of the PID loop (page 29).
Flow flutters or is jumpy.
The meters are very fast and will pick up any actual flow fluctuations such 
as from a diaphragm pump, etc. Also, inspect the inside of the upstream 
connection for debris such a PTFE tape shreds. Note: FLR-1600A & FLV-4600A 
Series devices feature a programmable geometric running average (GRA) that 
can aid in allowing a rapidly fluctuating flow to be read. Please see “Pressure 
Averaging” and “Flow Averaging” on page 21.
The output signal is lower than the reading at the display.
This can occur if the output signal is measured some distance from the meter 
as voltage drops in the wires increase with distance. Using heavier gauge wires, 
especially in the ground wire, can reduce this effect.
My controller oscillates wildly and/or exhibits very different reactions to the set-
point than I expect.
Conditions considerably different than those at which the device was originally 
set up can necessitate a re-tuning of the PID loop. Avoid long runs of small 
diameter tubing in the system, increase line size.
RS232 / RS485 Serial Communications is not responding.
Check that your meter is powered and connected properly. Be sure that the port 
on the computer to which the meter is connected is active. Confirm that the port 
settings are correct per the RS232 / RS485 instructions in this manual (Check the 
RS232 / RS485 communications select screen for current meter readings). Close 
HyperTerminal® and reopen it. Reboot your PC. See pages 12, 13 and 31 for more 
information on RS232 / RS485 signals and communications.
Slower response than specified.
FLR-1600A Series Meters and FLV-4600A Series Controllers feature a 
programmable Geometric Running Average (GRA). Depending on the full scale 
range of the meter, it may have the GRA set to enhance the stability/readability 
of the display, which would result in slower perceived response time. Please see 
“Pressure Averaging” and “Flow Averaging” on page 21.
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Jumps to zero at low flow.
FLR-1600A Series Meters and FLV-4600A Series Controllers feature a 
programmable zero deadband. The factory setting is usually 0.5% of full scale. 
This can be adjusted between NONE and 3.2% of full scale. See page 21.

MAINTENANCE AND RECALIBRATION
General: FLR-1600A and FLV-4600A Series Water Flow Meters and Controllers 
require minimal maintenance. The primary cause of damage and/or long-term 
inaccuracy in these devices is contamination and/or corrosion damage. Water 
should be filtered for particulates or biological materials that may grow in the 
device. When removing these units from the line for any extended period of 
time, make an effort to remove all of the water from the device, as deposits of 
calcium or other soluble minerals can affect the accuracy of the device.

Recalibration: The recommended period for recalibration is once every year. A 
label located on the back of the device lists the most recent calibration date. 
The device should be returned to the factory for recalibration within one year 
from the listed date. Before calling to schedule a recalibration, please note the 
serial number on the back of the meter. The Serial Number, Model Number, and 
Date of Manufacture are also available on the Model Info screen (page 23).

Cleaning: FLR-1600A and FLV-4600A Series Flow Meters/Controllers require no 
periodic cleaning. If necessary, the outside of the meter can be cleaned with a 
soft dry cloth. Avoid excess moisture or solvents.

For repair, recalibration or recycling of this product, contact Omega.

CCM CCH LPM LPH CFM CFH
CFH 0.0021 0.00003 2.1189 0.035 60.0 1.0
CFM 0.000035 0.0000005 0.035 0.00059 1.0 0.0166
LPH 0.06 0.001 60.0 1.0 1699.0 28.316
LPM 0.001 0.000017 1.0 0.0166 28.316 0.4719
CCH 60.0 1.0 60000.0 1000.0 1699011.0 28317.0
CCM 1.0 0.0167 1000.0 16.667 28317.0 471.947

Flow Conversion Table:
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Option: Totalizing Mode - Controllers
Controllers can be purchased with the Totalizing Mode option. This option adds 
an additional mode screen that displays the total flow (normally in the units of 
the main flow screen) that has passed through the device since the last time the 
totalizer was cleared. The Totalizing Mode screen is accessed by pushing the 
TOTAL button on the MAIN display. 

TOTAL/TIMER: Pushing the TOTAL/TIMER button 
will cycle the large numbers on the display 
between total mass and time elapsed.
Rollover – The customer can also specify at the 
time of order what the totalizer is to do when 
the maximum count is reached. The following 
options may be specified:
No Rollover – When the counter reaches the 
maximum count it stops counting until the 
counter is cleared.
Rollover – When the counter reaches the 
maximum count it automatically rolls over to 

zero and continues counting until the counter is cleared.
Rollover with Notification – When the counter reaches the maximum count 
it automatically rolls over to zero, displays an overflow error, and continues 
counting until the counter is cleared.

TOTAL MASS: The counter can have as many as seven digits. At the time of order, 
the customer must specify the range. This directly affects the maximum count. For 
instance, if a range of 1/100ths of a liter is specified on a meter which is totalizing in 
liters, the maximum count would be 99999.99 liters. If the same unit were specified 
with a 1 liter range, the maximum count would be 9999999 liters.
ELAPSED TIME: The small numbers below the mass total show the elapsed time 
since the last reset in hours, minutes and seconds. The maximum measurable 
elapsed time is 9999 hours 59 minutes 59 seconds. The hours count resets when 
RESET is pushed, an RS232 or RS485 clear is executed or on loss of power. Press 
ELAPSED TIME to show this as the primary display.
SETPT: Pushing SETPT will allow you to change the controller's set-point.
RESET – The counter can be reset to zero at any time by pushing the RESET 
button. To clear the counter via RS232 or RS485, establish serial communication 
with the meter or controller as described in the RS232 or RS485 section of the 
manual. To reset the counter, enter the following commands:

In Polling (addressable) Mode:  Address$$T <Enter>  (e.g. B$$T <Enter>)

SETPT
+123.4

MENU

SCCM
+123.4

TOTAL/
TIMER

BATCH RESET

0000:09:59    SCC
00123.45
00123.45 Batch Done
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BATCH PROCESSING MODE – CONTROLLERS ONLY
Batch mode is a function within the optional Totalizing mode. Batch mode is 
designed to provide repeatable, finite flow quantities. 

To activate Batch Mode: Press BATCH. Then use 
SELECT DIGIT to move the arrow to the desired digit, 
and the UP and DOWN buttons to change the value. 
Press CLEAR to return to zero. Press SET to record 
your value. If the controller has a non-zero Set-Point, 
flow will start immediately. If not, press SETPT to 
select a Set-Point.
Batch values can also be established via RS232/RS485 
communication using Register 92. (See RS232/RS485 
Section of this manual for serial communication methods.)
Note: While the Totalizer counter will still reset across 

power cycles, the Batch process value is stored in EEPROM and will remain valid 
until updated by the user.
While the Batch is processing, the desired Batch value is displayed above the 
totalizing counter on the Totalizer screen. Time elapsed during the Batch 
processing is displayed below the totalizing counter. Press TOTAL/TIMER to 
toggle these values.  
When the active Totalizer reaches the preset Batch value, flow ceases, and the 
display updates to “Batch Done”. The Totalizer timer also pauses. 

- To start a new batch of the same size, simply press 
RESET. The Totalizer can reproduce any number of 
fixed Batches in this manner. 
- To start a smaller batch, decrease the Batch value. 
The new batch begins when you press RESET. 
- To continue the existing batch to a larger total 
volume, increase the Batch value. Flow resumes as 
soon as you press OK in the Batch Value screen.
- To start a larger batch from scratch, first clear the 
flow Set-Point to zero to prevent unwanted flow. 

Then increase the Batch value, and select a flow Set-Point. Flow will begin when 
you press SET in the Set-Point screen.
- To cancel a batch in progress, clear the Set-Point and press SET.
Note: Batch mode operates independently of the desired flow rate, but requires 
a non-zero flow rate to run. The rate of flow is determined by the controller 
Set-Point value, which is established by the user via analog, front panel or serial 
communication methods. Batches can be produced more slowly or more rapidly 
as determined by the user-selected Set-Point flow rate.
To turn off Batch Mode: Set the Batch value to zero (0.0) via the front panel or 
RS232/RS485 communication using Register 92. If there is a non-zero flow Set-
Point, flow will immediately resume, and the Totalizer counter will continue per 
the user established Set-Point flow rate.

DOWN

SET

SELECT 
DIGIT

UP

BACK/ 
CANCEL CLEAR

˄
00123.45

SETPT
123.4

MENU

SCCM
+123.4

TOTAL/ 
TIMER

BATCH RESET

0000:09:59    SCC

00123.45 Batch Done

00123.45
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Omega Portable Meters and Gauges
Omega Rechargeable Flow Meters and Pressure Gauges use a Li-Ion 3.7V cell located in the top 
secti on of the device. The Li-Ion cell must not be removed.
Normal batt ery life of a fully-charged cell is 18 hours with a monochrome display or 
5 hours with a TFT color display, when the backlight is set to 10. Dimming the backlight 
will increase batt ery life.
The batt ery can be charged through either the micro-USB port or the mini-DIN connector. 
When the device is connected to external power it will functi on normally while the batt ery 
is charging. Note: If the batt ery has no charge, a charge ti me of one minute will be required 
before the unit can be turned on. Charge rates will be fastest through the micro-USB port 
using the included power supply or equivalent. The device will charge fastest when it is 
turned off . 
Recharge Time: 3.5 hours with 2A USB supply. The micro-USB port is for charging purposes only.
The green/red indicator LED on top of the device will light up green to indicate that the 
unit is charging. The green LED will turn off  when the batt ery is charged and the power 
switch is turned to “I” for ON. 
The indicator LED fl ashes red when the device has about 1 hour of batt ery life remaining. The 
LED will fl ash red at a faster rate when the device has about 15 minutes of batt ery life remaining. 
It is highly recommended that the device be charged immediately. When the batt ery charge runs 
out, the display contrast will turn to 0 and device performance is no longer guaranteed.

Output signals from the meter are passed through the mini-DIN connector on top 
of the device. Rechargeable batt ery units do not support 0-10V analog output. 
Receiver resistance must be below 250Ω.

Turn the power switch on top of the device to “O” for OFF when it is not in use.
Warning: If the device is left  ON unti l the batt ery can no longer power it, the 
charge indicator will fall out of sync with the actual charge. The device can be 
re-synced by fully charging the batt ery once.

A Batt ery Charge Indicator appears below Tare on the display:

CAUTION! D� ��� ������� �� ����� ��� ������ ������� �� ��� -10° 
�� +50°C ����������� �����. I� �������� ������� ������ ���� ��� 
����������� �� ������� �� ���� �����, ��� ������� �������� ���� ���� �� 0 
��� ��� �����’� ����������� �� �� ������ ����������. 

T�� ���� �������� ����������� ����� �� 0° �� +45°C. I� �������� ������� ������ 
������������ ������� �� ���� �����, ��� ������� ���� ��� ������.

#C
+21.50

+0.000
CCM MENU

TARE VPSIA
+13.60

+0.000
SCCM

95 – 100%

80 – 95%

50 – 80%

20 – 50%

5 – 20%

0 – 5%

TOP VIEW OF DEVICE

Green = Charging
Flashing Red = Low Battery

+5 Vdc
Charge Only

1 2

3 4 5

6 7 8 I  
 O

On / Off 
I / O
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Accessory: FMA1600-MDB Multi -Drop Box

The FMA1600-MDB Multi -Drop Box makes it convenient 
to wire multi ple fl ow and/or pressure devices to a single 
RS232 or RS485 port. Now available with a USB interface!

The Multi -Drop Box has nine 8 pin mini-DIN ports available. 
The ports are to be used with a standard double ended 8 pin 

mini-DIN (DC-62) style cable going from the box to each fl ow or pressure device. 

A single DB9 D-SUB type connector (COM PORT) connects, using the included 
cable, to the serial connector on a PC or laptop. 

All of the fl ow and/or pressure devices are powered via a terminal block on the 
front of the box. 

If more than nine devices will be required, additi onal Multi -Drop Boxes can be 
daisy chained together with a double ended 8 pin mini-DIN cable plugged into 
any receptacle on both boxes.

FMA1600-MDB Power Supply for Large Valve Controllers: The PS24VHC (Power 
Supply 24Vdc High Current) is a 6.5Amp 24Vdc power supply designed for 
running multi ple large controllers on a FMA1600-MDB. 

The 6.5Amp power supply can run as many as 8 large valve controllers, which 
makes it ideal for the FMA1600-MDB and multi ple large valve (or small valve / 
large valve combinati on) controllers on a FMA1600-MDB.

BB-9 Multi-Drop 
BoxØ .156 Thru 4 Places

1.75

Ø .340 Thru 2 PL

3.46

6.75 1.55

5.06

FMA1600-MDB Multi-Drop Box

Ø .156 Thru 4 Places

1.75

Ø .340 Thru 2 PL

Ø .175 Thru 2 PL

3.46

6.75 1.55

5.06

6.75

7.56



46

Accessories

Part Number Description

FMA1600-C1 8 Pin Male Mini-DIN connector cable, single ended, 
6 foot length

FMA1600-C2 8 Pin Male Mini-DIN connector cable, double ended, 
6 foot length

FMA1600-C3 8 Pin Male Mini-DIN to DB9 Female Adapter, 6 foot 
length

FMA1600-PSU Universal 100-240 VAC to 24 Volt DC Power Supply 
Adapter

FMA1600-CRA 8 Pin Male Right Angle Mini-Din Cable, single ended, 
6 foot length

FMA1600-C1-25FT 8 Pin Male Mini-DIN connector cable, single ended, 
25 foot length

FMA1600-C2-25FT 8 Pin Male Mini-DIN connector cable, double ended, 
25 foot length

FMA1600-MDB Multi-Drop Box
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Technical Data for FLR-1600A - Series Water Flow Meters
0 – 0.5 ccm Full Scale through 0 – 10 lpm Full Scale

FLR-1600A-Series water flow meters read both water flow and water temperature. An 
optional pressure sensor is also available.

Standard Specifications (Contact Omega for available options.)
Performance FLR-1600A Meters

Available Ranges 0.5 ccm to 10 lpm
Accuracy at calibration conditions after tare ± 2% Full Scale

Repeatability ± 2% Full Scale
Zero Shift and Span Shift 0.02% Full Scale / ºCelsius / Atm

Operating Range / Turndown Ratio 2% to 100% Full Scale / 50:1 Turndown
Maximum Flow Rate 128% FS Measurable

Typical Response Time 20 ms (Adjustable)
Warm-up Time < 1 Second

Operating Conditions FLR-1600A Meters
Operating Temperature +10 to +50 ºCelsius

Maximum Pressure 200 psig
Mounting Attitude Sensitivity None

Ingress Protection IP40

Wetted Materials 302 & 303 Stainless Steel, 316L Stainless Steel, FKM. 
If your application demands a different material, please contact Omega.

Communication / Power FLR-1600A Meters
Monochrome LCD Display with integrated 

touchpad
Simultaneously displays Flow and Temperature   

(optional Pressure sensor available)
Digital Output Signal1 Options RS232 Serial / RS485 Serial  

Analog Output Signal2 Options 0-5 Vdc / 1-5 Vdc / 0-10 Vdc / 4-20 mA  

Optional Secondary Analog Output Signal2 0-5 Vdc / 1-5 Vdc / 0-10 Vdc / 4-20 mA 
Electrical Connection Options 8 Pin Mini-DIN / 15-pin D-sub (DB15) 

Supply Voltage 7-30 Vdc   (15-30 Vdc for 4-20 mA outputs)
Supply Current 0.040 Amp

1. The Digital Output Signal communicates Flow and Temperature  (optional Pressure sensor available) 
2. The Analog Output Signal and Optional Secondary Analog Output Signal communicate your choice of Flow 

or Temperature

Range Specific Specifications
FLR-1600A Meters 

 Full Scale Flow
Pressure Drop1 at 

FS Flow (PSID)
Mechanical 
Dimensions Process Connections2

0.5 ccm to 1 ccm 2.0 4.4”H x 2.4”W x 1.1”D M5 (10-32) Female Thread
2 ccm to 500 ccm 2.0

4.6”H x 2.4”W x 1.1”D 1/8” NPT Female 
1 lpm 4.0
2 lpm 4.0 4.7”H x 2.7”W x 1.1”D 1/4” NPT Female
5 lpm 10.0

5.1”H x 4.0”W x 1.6”D 1/4” NPT Female
10 lpm 20.0

1. Lower Pressure Drops Available, please contact Omega.
2. Compatible with Beswick®, Swagelok® tube, Parker®, face seal, push connect and compression adapter fittings. VCR and 
SAE connections upon request.
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










  







 










  
























  






 

FLR-1600A:
0 - 0.5 ccm
0 - 1 ccm

FLR-1600A:
0 - 2 ccm
0 - 5 ccm
0 - 10 ccm
0 - 20 ccm
0 - 50 ccm
0 - 100 ccm
0 - 200 ccm
0 - 500 ccm

0 - 1 lpm
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






  


















 



FLR-1600A:
0 - 2 lpm








  










 











 

FLR-1600A:
0 - 5 lpm
0 -10 lpm
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Technical Data for FLV-4600A Water Flow Controllers
0 – 5 ccm Full Scale through 0 – 5 lpm Full Scale

FLV-4600A Series water flow controllers display both water flow and water temperature. An 
optional pressure sensor is also available.
Standard Specifications (Contact Omega for available options.)

Range Specific Specifications

Performance Small Valve  Controllers Large Valve Controllers
Available Ranges 5 ccm to 500 ccm 1 lpm to 5 lpm

Accuracy at calibration conditions 
after tare ± 2% Full Scale

Repeatability ± 2% Full Scale
Zero Shift and Span Shift 0.02% Full Scale / ºCelsius / Atm

Operating Range / Turndown Ratio 2% to 100% Full Scale / 50:1 Turndown
Maximum Flow Rate 102.4% FS Controllable

Typical Response Time 100 ms (Adjustable)
Warm-up Time < 1 Second

Operating Conditions Small Valve  Controllers Large Valve Controllers
Operating Temperature +10 to +50 ºCelsius

Maximum Pressure 150 psig
Mounting Attitude Sensitivity None Mount with valve cylinder vertical & upright

Valve Type Normally Closed
Ingress Protection IP40

Wetted Materials

FLV-4600A: 430FR Stainless Steel, 302 & 303 Stainless Steel, 316L 
Stainless Steel, FKM, Perfluoroelastomer. 
Large Valve Controllers Add 416 Stainless Steel, Polyoxymethylene (POM).
If your application demands a different material, please contact Omega.

Communication / Power Small Valve  Controllers Large Valve Controllers
Monochrome LCD Display with 

integrated touchpad
Simultaneously displays Flow and Temperature  

(optional Pressure sensor available)

Digital Input/Output Signal1 Options RS232 Serial / RS485 Serial  

Analog Input/Output Signal2 Options 0-5 Vdc / 1-5 Vdc / 0-10 Vdc / 4-20 mA  
Optional Secondary Analog  

Input/Output Signal2
0-5 Vdc / 1-5 Vdc / 0-10 Vdc / 4-20 mA 

Electrical Connection Options 8 Pin Mini-DIN / 15-pin D-sub (DB15) 
Supply Voltage 12-30 Vdc  (15-30 Vdc for 4-20 mA outputs) 24-30 Vdc
Supply Current 0.250 Amp 0.750 Amp

1. The Digital Output Signal communicates Flow and Temperature  (optional Pressure sensor available) 
2. The Analog Output Signal and Optional Secondary Analog Output Signal communicate your choice of 

Flow or Temperature 

Full Scale Flow Pressure Drop1 at 
FS Flow (PSID)

Mechanical 
Dimensions Process Connections2

Small Valve 
Controllers

5 ccm to 50 ccm 5.0
4.6”H x 3.6”W x 1.1”D 1/8” NPT Female100 ccm 5.0

200 ccm to 500 ccm 7.5
Large Valve 
Controllers

1 lpm 4.0
5.7”H x 7.7”W x 2.3”D 1/4”NPT Female2 lpm 4.0

5 lpm 10.0

1. Lower Pressure Drops Available, please contact Omega.
2. Compatible with Beswick®, Swagelok® tube, Parker®, face seal, push connect and compression adapter fittings. VCR and 
SAE connections upon request.
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FLV-4600A:
0 - 5 ccm

0 - 10 ccm
0 - 20 ccm
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0 - 500 ccm
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FLV-4600A:
0 - 1 lpm
0 - 2 lpm
0 - 5 lpm
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Eight Pin Mini-DIN Connector Pin-Outs
If your Instrument was ordered with the standard Eight Pin Mini-DIN 

connection, please be sure to reference the following pin-out diagram.

Standard 8 Pin Mini-DIN Pin-Out



 







1 2

3 4 5

6 7 8

Pin Function Mini-DIN 
cable color

1 Inactive (or optional 4-20mA Primary Output Signal) Black

2 Static 5.12 Vdc [or optional Secondary Analog Output (4-20mA, 
5Vdc, 10Vdc) or Basic Alarm] Brown

3 Serial RS232RX / RS485(–) Input Signal (receive) Red

4 Meters = Remote Tare (Ground to Tare)
Controllers = Analog Set-Point Input Orange

5 Serial RS232TX  / RS485(+) Output Signal (send) Yellow
6 0-5 Vdc (or optional 0-10 Vdc) Output Signal Green
7 Power In (as described above) Blue

8 Ground (common for power, digital communications, analog signals 
and alarms) Purple

Note: The above pin-out is applicable to all the flow meters and controllers with the 
Mini‑DIN connector. The availability of different output signals depends on the options 
ordered. Optional configurations are noted on the unit’s calibration sheet.
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DB15 Pin-Outs
If your instrument was ordered with a DB15 connection, be sure to check the 

Calibration Label on the device and reference the appropriate pin-out diagram.

DB15

Pin Number Function
1 Ground
2 Primary Analog Signal Output
3 Ground
4 N/C
5 Power Supply (+Vdc)
6 N/C
7 N/C

8  Analog Tare (meters — when grounded)
Analog Set-Point Input (controllers)

9 Power Supply Common
10 Ground
11 Secondary Analog Signal Output / fixed 5.12Vdc
12 N/C
13 RS232 RX (receive) or RS485 –
14 Ground
15 RS232 TX (send) or RS485 +

Check your device’s calibration certificate and user manual for the actual electrical input/
output requirements, as all instruments are custom configured to some extent.
NOTE: Pins 1, 3, 9, 10, and 14 are connected together inside of the device and are 
common grounding points.
N/C = Not Connected/Open (can be used for custom pin assignments – please consult factory).

The following pin-out chart describes the safest and generally compatible arrangement when 
connecting a non-FLR-1600A-Series DB15 wire to a DB15 equipped FLR-1600A-Series. Not 
all features may be available between brands, but the common denominators are featured in 
our DB15 offerings, along with some options for customization.

Male Connector Front View Female Connector Front View

8

15 13 11 9

25
8

1513119

2 5
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Pin Number Function
1 Ground
2 Primary Analog Signal Output

3 Analog Tare (meters — when grounded)*
Analog Set-Point Input (controllers)*

4 Ground
5 Power Supply Common
6 Ground
7 Power Supply (+Vdc)
8 RS232 Tx (send) / RS485, A (-) [receive]
9 Ground
10 N/C
11 N/C
12 Secondary Analog Signal Output / fixed 5.12Vdc*
13 N/C
14 N/C
15 RS232 Rx (receive) / RS485, A (+) [send]

Check your device’s calibration certificate and user manual for the actual electrical input/
output requirements, as all instruments are custom configured to some extent.
* Added to allow for full use of features on FLR-1600A-Series devices, may not be present on 
host wiring
NOTE: Pins 1, 4, 5, 6 and 9 are connected together inside of the device and are common 
grounding points.
N/C = Not Connected/Open (can be used for custom pin assignments – please consult factory).

DB15A 

The following pin-out chart describes the safest and generally compatible arrangement 
when connecting a non-FLR-1600A-Series DB15 wire to a DB15A equipped FLR-1600A-
Series. Not all features may be available between brands, but the common denominators are 
featured in our DB15 offerings, along with some options for customization.

Male Connector Front View Female Connector Front View

8

15 12 9

25
8

15129

2 53
3

7
7

DB15 Pin-Outs
If your instrument was ordered with a DB15 connection, be sure to check the 

Calibration Label on the device and reference the appropriate pin-out diagram.
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DB15B

Pin Number Function
1 Ground
2 Primary Analog Signal Output
3 N/C
4 N/C
5 Power Supply (+Vdc)
6 N/C
7 N/C

8 Analog Tare (meters — when grounded)
Analog Set-Point Input (controllers)

9 Power Supply Common
10 Ground
11 Secondary Analog Signal Output / fixed 5.12Vdc
12 N/C
13 N/C
14 RS232 RX (receive) or RS485 –
15 RS232 TX (send) or RS485 +

Check your device’s calibration certificate and user manual for the actual electrical input/
output requirements, as all instruments are custom configured to some extent.
NOTE: Pins 1, 9, and 10 are connected together inside of the device and are common 
grounding points.
N/C = Not Connected/Open (can be used for custom pin assignments – please consult factory).

The following pin-out chart describes the safest and generally compatible arrangement 
when connecting a non-FLR-1600A-Series DB15 wire to a DB15B equipped FLR-1600A-
Series. Not all features may be available between brands, but the common denominators are 
featured in our DB15 offerings, along with some options for customization.

9

5

Male Connector Front View Female Connector Front View

1415

8
8

1514119

2 5

11

2

DB15 Pin-Outs
If your instrument was ordered with a DB15 connection, be sure to check the 

Calibration Label on the device and reference the appropriate pin-out diagram.
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DB15K

The following pin-out chart describes the safest and generally compatible arrangement 
when connecting a non-FLR-1600A-Series DB15 wire to a DB15B equipped FLR-1600A-
Series. Not all features may be available between brands, but the common denominators are 
featured in our DB15 offerings, along with some options for customization.

Pin Number Function
1 N/C
2 Primary Analog Signal Output
3 N/C
4 N/C
5 Power Supply Common
6 N/C
7 Power Supply (+Vdc)

8 Analog Tare (meters — when grounded)
Analog Set-Point Input (controllers)

9 Secondary Analog Signal Output / fixed 5.12Vdc *
10 N/C
11 Ground
12 Ground
13 RS232 RX (receive) or RS485 – *
14 RS232 TX (send) or RS485 + *
15 Ground

Check your device’s calibration certificate and user manual for the actual electrical input/
output requirements, as all instruments are custom configured to some extent.
NOTE: Pins 5, 11, 12 and 15 are connected together inside of the device and are common 
grounding points.
N/C = Not Connected/Open (can be used for custom pin assignments – please consult 
factory).
* Added to allow for full use of features on FLR-1600A-Series devices, may not be present on 
host wiring.

Male Connector Front View Female Connector Front View

8

13 149

2 5
8

1314 9

25
7

7

DB15 Pin-Outs
If your instrument was ordered with a DB15 connection, be sure to check the 

Calibration Label on the device and reference the appropriate pin-out diagram.
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DB15H

Pin Number Function
1 N/C
2 RS232 RX (receive) or RS485 – *
3 N/C
4 N/C
5 Ground
6 Primary Analog Signal Output
7 Power Supply Common
8 N/C
9 N/C
10 Secondary Analog Signal Output / fixed 5.12Vdc *
11 Power Supply (+Vdc) 
12 Ground
13 N/C

14 Analog Tare (meters — when grounded)
Analog Set-Point Input (controllers)

15 RS232 TX (send) or RS485 + *
Check your device’s calibration certificate and user manual for the actual electrical input/
output requirements, as all instruments are custom configured to some extent.
NOTE: Pins 5, 11, 12 and 15 are connected together inside of the device and are common 
grounding points.
N/C = Not Connected/Open (can be used for custom pin assignments – please consult factory).
* Added to allow for full use of features on FLR-1600A-Series devices, may not be present on 
host wiring.

Male Connector Front View Female Connector Front View

11 151410

2 6

1115 14 10

26
7 7

The following pin-out chart describes the safest and generally compatible arrangement 
when connecting a non-FLR-1600A-Series DB15 wire to a DB15B equipped FLR-1600A-
Series. Not all features may be available between brands, but the common denominators are 
featured in our DB15 offerings, along with some options for customization.

DB15 Pin-Outs
If your instrument was ordered with a DB15 connection, be sure to check the 

Calibration Label on the device and reference the appropriate pin-out diagram.
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DB15S

Pin Number Function
1 Ground
2 Primary Analog Signal Output 
3 N/C
4 N/C
5 Ground
6 N/C
7 N/C

8 Analog Tare (meters — when grounded)
Analog Set-Point Input (controllers)

9 Power Supply Common
10 Ground
11 Secondary Analog Signal Output / fixed 5.12Vdc *
12 RS232 RX (receive) or RS485 – *
13 Power Supply (+Vdc) 
14 RS232 TX (send) or RS485 + *
15 Ground

Check your device’s calibration certificate and user manual for the actual electrical input/
output requirements, as all instruments are custom configured to some extent.
NOTE: Pins 1, 5, 9, 10 and 15 are connected together inside of the device and are common 
grounding points.
N/C = Not Connected/Open (can be used for custom pin assignments – please consult factory).
* Added to allow for full use of features on FLR-1600A-Series devices, may not be present on 
host wiring.

Male Connector Front View Female Connector Front View

11 141312

2

9 1114 13 9

2
8

8

12

The following pin-out chart describes the safest and generally compatible arrangement 
when connecting a non-FLR-1600A-Series DB15 wire to a DB15B equipped FLR-1600A-
Series. Not all features may be available between brands, but the common denominators are 
featured in our DB15 offerings, along with some options for customization.

DB15 Pin-Outs
If your instrument was ordered with a DB15 connection, be sure to check the 

Calibration Label on the device and reference the appropriate pin-out diagram.



WARRANTY/DISCLAIMER
OMEGA ENGINEERING, INC. warrants this unit to be free of defects in materials and
workmanship for a period of 13 months from date of purchase. OMEGA’s WARRANTY adds
an additional one (1) month grace period to the normal one (1) year product warranty to
cover handling and shipping time. This ensures that OMEGA’s customers receive maximum
coverage on each product. 
If the unit malfunctions, it must be returned to the factory for evaluation. OMEGA’s Customer
Service Department will issue an Authorized Return (AR) number immediately upon phone or
written request. Upon examination by OMEGA, if the unit is found to be defective, it will be
repaired or replaced at no charge. OMEGA’s WARRANTY does not apply to defects resulting
from any action of the purchaser, including but not limited to mishandling, improper
interfacing, operation outside of design limits, improper repair, or unauthorized modification.
This WARRANTY is VOID if the unit shows evidence of having been tampered with or shows
evidence of having been damaged as a result of excessive corrosion; or current, heat, moisture
or vibration; improper specification; misapplication; misuse or other operating conditions
outside of OMEGA’s control. Components in which wear is not warranted, include but are not
limited to contact points, fuses, and triacs.
OMEGA is pleased to offer suggestions on the use of its various products. However, 
OMEGA neither assumes responsibility for any omissions or errors nor assumes
liability for any damages that result from the use of its products in accordance with
information provided by OMEGA, either verbal or written. OMEGA warrants only
that the parts manufactured by the company will be as specified and free of
defects. OMEGA MAKES NO OTHER WARRANTIES OR REPRESENTATIONS OF ANY
KIND WHATSOEVER, EXPRESSED OR IMPLIED, EXCEPT THAT OF TITLE, AND ALL
IMPLIED WARRANTIES INCLUDING ANY WARRANTY OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE ARE HEREBY DISCLAIMED. LIMITATION OF
LIABILITY: The remedies of purchaser set forth herein are exclusive, and the total
liability of OMEGA with respect to this order, whether based on contract, warranty,
negligence, indemnification, strict liability or otherwise, shall not exceed the
purchase price of the component upon which liability is based. In no event shall
OMEGA be liable for consequential, incidental or special damages.
CONDITIONS:  Equipment sold by OMEGA is not intended to be used, nor shall it be used: (1)
as a “Basic Component” under 10 CFR 21 (NRC), used in or with any nuclear installation or
activity; or (2) in medical applications or used on humans. Should any Product(s) be used in or
with any nuclear installation or activity, medical application, used on humans, or misused in
any way, OMEGA assumes no responsibility as set forth in our basic WARRANTY/ DISCLAIMER
language, and, additionally, purchaser will indemnify OMEGA and hold OMEGA harmless from
any liability or damage whatsoever arising out of the use of the Product(s) in such a manner.

RETURN REQUESTS/INQUIRIES
Direct all warranty and repair requests/inquiries to the OMEGA Customer Service Department.
BEFORE RETURNING ANY PRODUCT(S) TO OMEGA, PURCHASER MUST OBTAIN AN
AUTHORIZED RETURN (AR) NUMBER FROM OMEGA’S CUSTOMER SERVICE DEPARTMENT
(IN ORDER TO AVOID PROCESSING DELAYS). The assigned AR number should then be
marked on the outside of the return package and on any correspondence.
The purchaser is responsible for shipping charges, freight, insurance and proper packaging to
prevent breakage in transit. 

FOR WARRANTY RETURNS, please have
the following information available BEFORE 
contacting OMEGA:
1. Purchase Order number under which 

the product was PURCHASED,
2. Model and serial number of the product

under warranty, and
3. Repair instructions and/or specific 

problems relative to the product.

FOR NON-WARRANTY REPAIRS, consult
OMEGA for current repair charges. Have the
following information available BEFORE 
contacting OMEGA:
1. Purchase Order number to cover the 

COST of the repair,
2. Model and serial number of theproduct, and
3. Repair instructions and/or specific problems 

relative to the product.
OMEGA’s policy is to make running changes, not model changes, whenever an improvement is possible. 
This affords our customers the latest in technology and engineering.
OMEGA is a registered trademark of OMEGA ENGINEERING, INC.
© Copyright 2009 OMEGA ENGINEERING, INC. All rights reserved. This document may not be copied, photocopied,
reproduced, translated, or reduced to any electronic medium or machine-readable form, in whole or in part, without
the prior written consent of OMEGA ENGINEERING, INC.



Where Do I Find Everything I Need for 
Process Measurement and Control? 

OMEGA…Of Course!
Shop online at omega.com SM

TEMPERATURE
 Thermocouple, RTD & Thermistor Probes, Connectors, Panels & Assemblies
 Wire: Thermocouple, RTD & Thermistor
 Calibrators & Ice Point References
 Recorders, Controllers & Process Monitors
 Infrared Pyrometers

PRESSURE, STRAIN AND FORCE
 Transducers & Strain Gages
 Load Cells & Pressure Gages
 Displacement Transducers
 Instrumentation & Accessories

FLOW/LEVEL
 Rotameters, Gas Mass Flowmeters & Flow Computers
 Air Velocity Indicators
 Turbine/Paddlewheel Systems
 Totalizers & Batch Controllers

pH/CONDUCTIVITY
 pH Electrodes, Testers & Accessories
 Benchtop/Laboratory Meters
 Controllers, Calibrators, Simulators & Pumps
 Industrial pH & Conductivity Equipment

DATA ACQUISITION
 Data Acquisition & Engineering Software
 Communications-Based Acquisition Systems
 Plug-in Cards for Apple, IBM & Compatibles
 Datalogging Systems
 Recorders, Printers & Plotters

HEATERS
 Heating Cable
 Cartridge & Strip Heaters
 Immersion & Band Heaters
 Flexible Heaters
 Laboratory Heaters

ENVIRONMENTAL
MONITORING AND CONTROL
 Metering & Control Instrumentation
 Refractometers
 Pumps & Tubing
 Air, Soil & Water Monitors
 Industrial Water & Wastewater Treatment
 pH, Conductivity & Dissolved Oxygen Instruments M0000/0009M-3792/0115


